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Welcome3

Welcome to Blackmagic H.264 Pro Recorder!

Thank you for purchasing H.264 Pro Recorder. Now you can easily convert your videos to H.264 in real time 
for the web, iPhone, iPad, Apple TV, YouTube and more!

Previously, H.264 encoding was either a very slow software process or required fast, expensive computer 
hardware. H.264 Pro Recorder has a built-in high quality H.264 hardware-encoding engine and image 
processor so you get amazing quality H.264 video in real time. 

H.264 Pro Recorder produces stunning quality digital video from the highest quality SDI, HDMI and 
component analog video as well as regular composite analog video. It can even work with S-Video via a 
third party S-Video breakout cable (not included) and supports 2 channels of professional balanced audio 
input. With all these connections supported, you can encode from practically any device out there. It even 
has an RS-422 remote control port so you can batch capture H.264 video from your decks just as you would 
with normal video!

We think it should take you approximately 5 minutes to complete the installation. Before you install H.264 
Pro Recorder, please check our website at www.blackmagic-design.com/support/ and click the support 
page to download the latest updates to this manual and H.264 Pro Recorder software. 

Lastly, please register your H.264 Pro Recorder when downloading software updates. We would love 
to keep you updated on new software updates and new features for your H.264 Pro Recorder. We are 
constantly working on new features and improvements, so we would love to hear your suggestions for 
improvements to the software!

Grant Petty
CEO Blackmagic Design

http://www.blackmagic-design.com/support/
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Blackmagic H.264 Pro Recorder

Audio Left

Audio Right

Y or NTSC/PAL

Analog video input

Analog audio input
on 1/4” TRS jacks

B-Y or S-VIDEO Y

R-Y or S-VIDEO C
RS-422 Deck Control

3G/HD/SD-SDI Input

USB 2.0 Connection

Power
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Pre-installation overview and planning
H.264 Pro Recorder features an SD/HD-SDI input with a BNC  input for connection to broadcast and 
professional, digital video sources. An HDMI input is also included for use with professional and consumer 
video sources with HDMI output, such as modern video cameras. Three BNC ports provide analog video 
input which can be switched between component, S-Video and composite analog video. These BNC 
ports are designed for connecting to legacy broadcast and professional, analog video sources such as 
a Sony Betacam SP™ deck. Consumer video sources can easily use these same connections by adding 
inexpensive BNC to RCA adapters or a dual-BNC to S-Video adapter cable. Two channels of professional, 
balanced, analog audio input is also supported using 1/4 inch jack connections. Remote control of video 
decks is also supported by the built-in RS-422 port. A USB 2.0 port and Media Express capture software for 
Mac OS X and Windows is also included.

The SDI, HDMI and component input connections are switchable between SD and HD video. S-Video and 
composite analog video are standard definition formats which only support NTSC and PAL video.

H.264 Pro Recorder requires QuickTime™ be installed for Mac OS X or Windows. QuickTime can be 
downloaded from Apple’s website at http://www.apple.com/quicktime/download/.

Blackmagic Media Express capture software requires a computer display resolution of 1280 x 800 or higher, 
and preferably 1920 x 1080 or 1920 x 1200.

Blackmagic Media Express software must be used to record video with the H.264 Pro Recorder hardware. 
Third party software applications cannot currently be used to record video with the H.264 Pro Recorder 
hardware. Once you have recorded your video to MP4 files with H.264 Pro Recorder, you should be able to 
play back your H.264 movies with almost any software which supports QuickTime.

Blackmagic Media Express software runs on Mac OS X and Windows computers and uses a USB 2.0 
connection to H.264 Pro Recorder. You will need to provide a USB 2.0 type A to mini B male cable. This 
same USB cable can be used for applying occasional firmware updates downloaded from the Blackmagic 
Design website. Programmable firmware can provide new features, compatibility with new hardware and 
support for new formats.

H.264 Pro Recorder requires mains power and includes a universal power supply with international power 
socket adapters for all countries. To stop power from being accidentally disconnected, a cable tie point is 
included next to the power socket to lock down the power connection. You will need to provide a mains 
power socket for the universal power supply.
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Installing the software for Mac OS X

Contents

The Desktop Video software installer will install the following components which are used by H.264 Pro 
Recorder:

�� Blackmagic Desktop Video drivers

�� Blackmagic Media Express

The Desktop Video software installer will also install the following components which are used by other 
Blackmagic Design capture products when installed on the same computer:

�� Blackmagic Design system preference
�� Blackmagic Disk Speed Test
�� Blackmagic LiveKey
�� Blackmagic Multibridge Utility
�� Adobe® presets and plug-ins
�� Apple Final Cut Pro™ Easy Setups, presets and enablers
�� QuickTime™ codecs

Note: Before installing any software or hardware you will need administrator privileges.

Desktop Video software

1.	 The CD supplied with the H.264 Pro Recorder contains the Desktop Video software. Before you 
install, ensure you have the very latest driver. Visit www.blackmagic-design.com/support

2.	 Open the “Desktop Video Installer” folder and launch the “Desktop Video Installer”.

3.	 Click Continue, Agree and Install buttons and the drivers will be installed on your system.

4.	 Now restart your machine to enable the new software drivers.

Follow the Desktop Video installer prompts.
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Installing the software for Windows

Contents

The Desktop Video software installer will install the following components which are used by H.264 Pro 
Recorder:

�� Blackmagic Desktop Video drivers

�� Blackmagic Media Express

The Desktop Video software installer will also install the following components which are used by other 
Blackmagic Design capture products when installed on the same computer:

�� Blackmagic Design Control Panel
�� Blackmagic Disk Speed Test
�� Blackmagic LiveKey
�� Blackmagic Multibridge Utility
�� Blackmagic AVI and QuickTime™ codecs
�� Adobe® presets and plug-ins

Desktop Video software

1.	 The CD supplied with the H.264 Pro Recorder contains the Desktop Video software. Before you 
install, ensure you have the very latest driver. Visit www.blackmagic-design.com/support

2.	 Open the “Desktop Video” folder and launch the “Desktop Video” installer.

3.	 The drivers will now be installed on your system. An alert will appear: “Do you want to allow 
the following program from an unknown publisher to make changes to this computer?”  
Click Yes to continue.

4.	 You will see a dialog bubble saying “found new hardware” and the hardware wizard will appear. 
Select “install automatically” and the system will find the required Desktop Video drivers. You will 
then receive another dialog bubble saying “your new hardware is ready for use.”

5.	 Now restart your machine to enable the new software drivers.

Click “Yes”.

Follow the Desktop Video Setup Wizard prompts

Restart your PC!
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How to update the H.264 Pro Recorder software!
Blackmagic Design will release new software for your H.264 Pro Recorder with new features, bug fixes and 
increase compatibility with third party software and devices.

To update your H.264 Pro Recorder with new software, simply connect it to your computer via USB and your 
computer will let you know if a new software update for your H.264 Pro Recorder is available.�

Once the software installation has been completed and H.264 Pro Recorder is powered on, connect it to a 
USB 2.0 port on your computer. The Desktop Video driver software will automatically check the H.264 Pro 
Recorder software if it is up to date. Software updates can provide new features, compatibility with new 
hardware and support for new formats.

If the software version does not match, the software will offer to update the firmware. This is 
automatic and all you need to do is click Update now to start the process. The update will take about  
1 minute to complete. If no software update is required, no message will appear. Please skip the rest of the 
steps in this section as your H.264 Pro Recorder is already up to date.

The following message should appear at completion of the update: “Software Update Complete. The 
firmware on your H.264 Pro Recorder was updated successfully. Please unplug both power and USB cables 
to restart it.” Click OK to dismiss the message and then unplug the power and USB cables from H.264 Pro 
Recorder and then reconnect them again.

H.264 Pro Recorder is now ready to be used.

This message will appear if a software update is required.

The update will take about 1 minute to complete.

When the update has completed, unplug the power and 
USB cables from H.264 Pro Recorder and then reconnect 
them again.
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Media Express overview

Blackmagic Media Express is a sophisticated software application which enables H.264 Pro Recorder users to 
capture video and audio to industry standard MP4 files with frame accurate RS-422 device control. It automatically 
detects whether the video source is HD1080, HD720, NTSC or PAL and also automatically detects the frame rate. 
Capture from progressive and interlaced video sources is supported and the captured file is stored in a progressive 
format for maximum compatibility with media player software on Mac OS X, Windows and portable video players.

Media Express has an intuitive interface and requires a 1920 x 1200, 1920 x 1080 or 1280 x 800 pixel computer 
display to compliment its uncluttered appearance. The capture view is the main view used with H.264 Pro 
Recorder. The master view is not used by H.264 Pro Recorder but may be used with other Blackmagic Design 
capture and playback products. The capture, playback and master views are color-coded so you will know at a 
glance which mode is being used.

Media Express uses many of the same keyboard shortcuts which are standard in the video industry so there is 
little to learn. Use j, k, l to shuttle backwards, pause and shuttle forwards, or use i and o to mark in and 
out points when batch capturing. Hold down the control and shift keys to reveal a jog wheel and then use your 
mouse, with the jog wheel, for precision control of your video deck.

VITC timecode is supported via RS-422 and RP188 timecode is supported via SDI.

H.264 Pro Recorder users can use the Media List feature to log multiple clips for batch capture.

Blackmagic Media Express is not NLE software and does not have a timeline. It is a great tool when you don’t 
need the complexity of NLE software but simply want to capture old or new programming content into the same 
file format used on the web, iPad™, iPod™, iPhone™, Apple TV™, YouTube™ and more.
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Device Menu

Media List

Search field

Remote indicator

VTR / deck timecode

Video Preview

Transport Control

Mark In / Mark Out

Track enable/disable

Project name, video format  
and frame rate

Blackmagic Media Express 2 Interface
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Blackmagic Media Express can be used with all professional capture products from Blackmagic Design. If you 
have more than one Blackmagic capture product installed, it is necessary to select which one will be used by 
Media Express. If H.264 Pro Recorder is the only Blackmagic capture device connected to your computer, then 
you can safely skip the rest of this section.

If you have more than one Blackmagic capture product installed, go to the Device menu in Media Express 
and select H.264 Pro Recorder. In the example pictured on this page, a DeckLink card and a H.264 Pro 
Recorder are both installed in the same computer. Selecting H.264 Pro Recorder will change the preferences 
displayed in Media Express, so you can choose suitable H.264 settings for your project.The Device menu in Media Express is used to select the 

desired Blackmagic capture device. Choose H.264 Pro 
Recorder.
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Media Express preferences are accessed from Media Express>Preferences on Mac OS X or 
Edit>Preferences on Windows. Any settings which are grayed out are only used with other Blackmagic 
Design capture products and are not required by H.264 Pro Recorder.

Project Video Format

Project Video Format defines the frame size of the current H.264 project. Choose “Native (Progressive)” for 
full resolution encoding of your video or select from a number of popular device presets including iPad and 
YouTube. H.264 Pro Recorder automatically detects the frame rate of your video.

Capture File Format 

The Capture File Format always sets the video codec to H.264, and the file format to MP4, when using H.264 Pro 
Recorder. Other choices appear in this menu when using other Blackmagic Design capture products.

The Quality button provides access to the H.264 encoding settings and is only available when H.264 Pro 
Recorder has detected a valid video input signal. We recommend leaving the maximum bit rate unchanged from 
the default setting.

Other preferences 

Other preferences for H.264 Pro Recorder include defining the storage location for your video and still frame 
captures, stopping the capture if dropped frames are detected, setting widescreen standard definition to 
anamorphic, and also pre-roll and timecode offset settings for tape decks with an RS-422 connection.

Preferences in Mac OS X

Video formats are provided for popular devices as well as full 
resolution, Native (Progressive) video.

The Quality button provides access to the H.264 encoding 
settings.
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The Media List holds a list of clips used in a project. When in Capture view, the Media List can be a list of clips to 
be batch-captured. Media List becomes a playlist when used in Playback view. These views are explained later 
in the manual.

The Media List is a project which can contain clips of the same frame size and frame rate.

The list can be sorted by each column heading. Columns can be rearranged and widened if desired.

The order of the clips in the list can be sorted manually by dragging and dropping within the list. Single or 
multiple clips can be dragged and dropped together.

The film strip icon on the left of the list shows whether a clip has linked media. If a clip has no linked media, 
the film strip icon displays a red “X” and selecting the clip will show a “Media Offline” message in the Video 
Preview Window.

Clips can be added to the list by:

�� double-clicking on an empty area in the list
�� selecting File > Import > Media Files
�� right-clicking on the list and selecting ‘Import Media Files’
�� capturing a clip from tape, camera, disk recorder some other video source.

Right-clicking in the Media List will open a contextual menu to perform operations such as “Batch Capture”. 
Depending upon the menu item chosen, Media Express will switch to the appropriate Capture or Playback view 
that fits the operation.

Media List showing an untitled clip which is not linked to any media. Right-clicking on the missing media icon will reveal a 
contextual menu from where Batch Capture can be selected.

Contextual menu
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Capture View showing the contextual menu, in the Media List, can be used to start a Batch Capture. This performs the same function as clicking the Get Clip button.
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Capture operations are performed in the Capture view (ctrl-1, cmd-1)
Capturing on the fly with H.264 Pro Recorder. 

Ensure the Project Video Format is set to the format of video you wish to capture.

Connect a video source to an input of the H.264 Pro Recorder. Only connect one video source to H.264 Pro 
Recorder so that it can auto-detect which source to use, e.g. SDI, HDMI, component, S-Video or composite 
analog video.

If deck control is required, ensure an RS-422 serial cable is connected and “remote” has been selected on the 
deck. If an RS-422 cable is not connected, or “remote” is not selected on the deck, the transport controls will be 
grayed out and “No Remote” will be displayed in the top right corner of the Video Preview Window.

Enter Reel and Name information into the information area. The Name will be applied to the clip(s) which are 
about to be captured.

Before capturing, the audio channels to be captured can be switched on or off via the track enable/disable 
buttons. The video track cannot be turned off.

Click on the gray “Capture” button to commence capturing. The button will highlight in red.

To end capture, click on the “Capture” button again. Alternatively, if you decide you don’t wish to save the 
captured clip, press the “Esc” key and a message will appear with an option to delete the clip.

Logging Clips for future batch capture with H.264 Pro Recorder.

Click the Mark In button to mark the In point, or use the shortcut key i.

Click the Mark Out button to mark the Out point, or use the shortcut key o.

Click the Log Clip button to log the clip, or use the shortcut key p. The entry should now appear in the Media 
List window.

Continue logging other clips.

When logging is completed, select the clips in the Media List and either:

�� Click on the ‘Get Clip(s)’ button.
�� Right-click on the selection and select ‘Batch Capture’.
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Capturing a clip with precise In and Out timecode with H.264 Pro Recorder.

Click on the Mark In button to mark the In point or use the shortcut key i.

Click on the Mark Out button to mark the Out point or use the shortcut key o.

Click on the Get Clip button. 

Media Express will cue the tape and precisely capture the clip from the In to the Out timecode points, including 
any handles specified in the application preferences.

While capturing, if the file name (Name) of a clip already exists on the selected capture drive, the user will be 
prompted if they want to over-write the file or not. If ‘No’ is selected, the file name will be auto-incremented 
with a number.
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Playback View
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Playback operations are performed in the Playback tab (ctrl-2, cmd-2)
Playing back captured clips

You can play back H.264 files in the Video Preview Window of Media Express, and monitor audio via the default 
sound output of your computer. Alternatively QuickTime Player, iTunes, Windows Media Player and VLC can all 
be used to play back your H.264 files in full screen.

Importing clips into the Media List

Import media into the Media List using one of the following methods:

�� Double-click on an empty area of the list.
�� Select File > Import > Media Files.
�� Right-click on the list and select ‘Import Media Files’.
�� Capture a clip from a video source such as camera or tape.

Any of these actions will reveal an Open Video Clip window where one or more files can be selected.

If the files being imported match the frame rate and size of those in the Media List, the import will be successful.

If the files being imported do not match the frame rate and size of existing clips in the Media List, the user will be 
prompted to create a new project and to save the current project.

If the current project has had no changes, and has already been saved, the user will only be prompted to start a 
new project as there is no need to save the existing project.

Playing back a single clip

Selecting a clip (single click) on the list will load it into the Video Preview Window.

To play back a single clip in the Media List, double click the clip and it will start playing in the Video Preview Window.

To loop the playback of the clip, click on the loop button in the transport control. The selected clip will now play 
back and loop until the user clicks on the pause button or presses the spacebar.

Playing back multiple clips

To play back multiple clips, select the clips in the Media Library and click the Play button or press the spacebar. 
Selected clips in the playlist will be played back in sequence. Unselected clips will not be played.

If no clips are selected, the whole playlist is played back, starting from the last-played clip.

Clicking on the loop button will cause the playback to loop.

During playback, the audio channels being monitored can be switched on or off via the track enable/disable 
buttons. The video track cannot be turned off.
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Which connections should I use for best quality video?
Choosing the best video connections to use with cameras, decks, capture cards and other video equipment 
can be confusing but it’s easy with H.264 Pro Recorder. Simply choose the best quality uncompressed 
output connection provided by each piece of video hardware. For example, H.264 Pro Recorder can 
capture composite analog video, from an old field deck, but can also capture HDMI from the latest DSLR 
cameras and even HD-SDI digital video and audio from an ARRI ALEXA camera or HDCAM SR deck.

If you are capturing from analog video equipment, you will also need to connect the left and right analog 
audio cables in addition to any video cables. By contrast, HDMI and SDI digital connections only need a 
single cable to carry both digital video and digital audio.

Composite — Good analog video

Composite is the oldest and most common analog video format and is often regarded as “regular video”. 
You are likely to find it on almost any video device. Broadcast and professional video equipment will usually 
have a single BNC connector for composite video whereas consumer equipment will usually use a single, 
yellow RCA connector. An inexpensive BNC-RCA adapter can be used to connect composite video from 
consumer equipment to the BNC connector on H.264 Pro Recorder.

S-Video — Better analog video

S-Video is higher quality than composite video and became a mainstream consumer standard in the 
late 1990s. It can also be found on some professional video hardware. Professional video equipment will 
sometimes have dual BNC connectors for S-Video labelled “Y” and “C”, whereas consumer equipment 
will use a single, multi-pin S-Video connector.

�� “Y” and “C” ports connect directly to the S-Video Y and S-Video C ports on H.264 Pro Recorder using 
BNC cables.

�� When connecting a multi-pin S-Video port to H.264 Pro Recorder, an inexpensive third party, breakout 
cable (not included) is required. The breakout cable adapts a single, S-Video connector to two BNC 
connectors on the H.264 Pro Recorder.

Component — Best analog video

Component is the highest quality analog video connection. It appeared on broadcast and professional 
video equipment during the 1990s and finally became popular on consumer equipment during the 2000s. 
It uses three cables to transmit all of the color information. On broadcast and professional video equipment, 
BNC connections are usually used. On consumer equipment, RCA connectors are used on three cables 
which are usually colored red, green and blue. Inexpensive BNC-RCA adapters can be used to connect 
component video from consumer equipment to the three BNC connectors on H.264 Pro Recorder.
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HDMI and SDI — Digital video is the best!

HDMI and SDI are digital protocols which provide the highest quality video to H.264 Pro Recorder.  
A single cable is used to transmit all of the color and audio information.

If you have a choice of using analog or digital connections, always choose digital for the best quality video 
and audio.

HDMI provides the same uncompressed, digital quality as high-end SDI digital video but at a much lower 
cost. It is designed to be used over short distances and standard cables are typically only 6 feet or 2 meters 
in length. HDMI is often found on consumer equipment as well as on some professional equipment. The 
HDMI cable can be directly connected to the HDMI port on H.264 Pro Recorder.

SDI and HD-SDI provide industrial grade connections for uncompressed, digital video. SDI cables 
support transmission of uncompressed digital video over at least 300 feet or 100 meters. SDI and HD-SDI 
connections are found on high-end broadcast and professional video hardware. An SDI or HD-SDI cable 
can be directly connected the SDI / HD-SDI port on H.264 Pro Recorder.

How does H.264 Pro Recorder know which input connections to use?

H.264 Pro Recorder auto-detects the video input you wish to use, i.e. SDI, HDMI, component, S-Video or 
composite analog video. For this reason, only connect one video source to H.264 Pro Recorder so it can 
auto-detect which source to use. If you are using analog video, you can also connect analog audio at the 
same time as expected. The RS-422 remote connection does not affect video input auto-detection.
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Consumer Level Analog Audio Signals
Can I use H.264 Pro Recorder with consumer level analog audio signals?

Yes and no! H.264 Pro Recorder is designed to work with professional, balanced, analog audio equipment. 
It does not work directly with unbalanced, consumer level analog audio. In order to capture unbalanced 
audio from consumer equipment, a line level converter can be used.

It is not necessary to buy an expensive line level converter. Low cost models exist and do a great job. 

Please refer to the support note Working with Consumer Level Analog Audio Signals which contains  
more detailed information including any, inexpensive line level converters that we have tested and have 
found to work well.

http://www.blackmagic-design.com/support/detail.asp?techID=174
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Receive  
(–)

Receive  
(+)

Transmit  
(–)

Transmit  
(+)

Ground 
Pins

2 7 8 3 1, 4, 6, 9

5 4 3 2 1

9 8 7 6

RS-422 remote device control
H.264 Pro Recorder features an industry standard, Sony™ compatible, RS-422 deck control port which has 
the correct pin connections for a direct connection to any deck.

You can use pre-manufactured 9 pin cables as long as each end of the cable are wired “pin for pin” 
where the same pin number on each end of the cable are connected together. If you would like to make 
custom cables, e.g. for extra length, please refer to the accompanying wiring diagram. 

Remote pin connections.
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There are four steps to getting help.
Step 1.	 Check out the Blackmagic Design web site www.blackmagic-design.com and click on the 	
	 “Support” page for the latest support information.

Step 2. 	 Call your dealer.

Your dealer will have the latest technical updates from Blackmagic Design and should be able 
to give you immediate assistance. We also recommend you check out the support options your 
dealer offers as they can arrange various support plans based on your workflow requirements.

Step 3. 	 The next option is to email us with your questions using the web form at 
	 www.blackmagic-design.com/support/contact

Step 4. 	 Phone a Blackmagic Design support office. Check our web site for current support phone 	
	 numbers in your area. www.blackmagic-design.com/company.

Please provide us with as much information as possible regarding your technical problem and 
system specifications so that we may try to respond to your problem as quickly as possible.

http://www.blackmagic-design.com
http://www.blackmagic-design.com/support/contact
http://www.blackmagic-design.com
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Component Analog Video Connections
H.264 Pro Recorder’s analog video BNC connectors can be used for component analog video capture, 
in high definition or standard definition.

Y

Component video input B-Y

R-Y
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S-Video Analog Connections
H.264 Pro Recorder’s analog video BNC connectors can be used for S-Video analog video capture 
in standard definition. While some analog decks provide S-Video Y and C ports using two BNC 
connectors, other analog equipment uses a single S-Video connector. A simple S-Video to dual BNC 
adapter cable (not included) can be used for S-Video capture as illustrated below.
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Composite Analog Video Connection
H.264 Pro Recorder’s analog video BNC connectors can be used for NTSC/PAL capture in standard definition.

Composite video input
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VIDEO INPUT

REF. VIDEO

VIDEO

VIDEO

COMPONENT 2 COMPONENT 2

COMPONENT 1 COMPONENT 1

IN OUT AUDIO

CH-1 CH-2

CH-1 CH-2

S VIDEO

S VIDEO

TIME CODE MONITOR

REMOTE TBC REMOTE

VIDEO OUTPUT AUDIO INPUT

AUDIO OUTPUT

Betacam SP analog deck
This example shows H.264 Pro Recorder connected to an analog deck for component analog video 
and audio capture from the deck.
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SDI digital deck
This example shows H.264 Pro Recorder connected to a standard definition digital deck for capture 
from the SDI deck.

ANALOG VIDEO I/O DIGITAL AUDIO I/O (AES/EBU)

REF VIDEO

IN

IN

IN

IN1

2

3

OUT

CH-1 CH-2 CH-3 CH-4

CH-1 CH-2 CH-3 CH-4

IN

OUT
OUT

OUT

OUT

OUT

VIDEO IN

VIDEO OUT

S VIDEO

MONITOR AUDIO

AUDIO OUT

AUDIO IN

SDI OUTPUT SDI INPUT

TIME CODE

VIDEO CONTROL

CONTROL PANEL

REMOTE - INAC IN

REMOTE - OUT

COMPONENT VIDEO
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ANALOG I/O DIGITAL I/O (AES/EBU) DIGITAL I/O

AUDIO OUTPUT REF INPUT INPUT HD SDI INPUT

HD SDI OUTPUT

FORMAT CONV. OUT (OPTION)

MONITOR1 2

SD SDI OUTPUT

FC OUT BOUTPUT

AUDIO
A 1

2B(OPTION)

B(OPTION) B(OPTION) B(OPTION)

1
A

2
A

MONITOR
A

1 2 MONITOR

INPUT
MONITOR

B INPUT
MONITOR

CH1/2 CH3/4

CH5/6 CH7/8

CH9/10 CH11/12

AUDIO

MONITOR OUTPUT

CUE HD REF OUT SD OUT

TIME CODE

IN OUTR L

CH3 CH4 1 2

1 SYNC

2
COMPOSITE
(MONITOR)

CH1 CH2

IN OUT

CH1/2 CH3/4

CH5/6 CH7/8

CH9/10 CH11/12

REMOTE 2 PARALLEL I/O (50P)

REMOTE 1-IN (9P) REMOTE 1-IN/OUT (9P)

RS422

USB

VIDEO CONTROL

Sony HDCAM SR deck in 4:2:2
This example shows H.264 Pro Recorder connected to a Sony HDCAM SR™ series digital deck in YUV 
4:2:2 HD mode for capture from the HD-SDI deck.
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HDMI camera
H.264 Pro Recorder captures video in real-time directly from the HDMI output of still cameras and 
video cameras, including AVCHD and HDV cameras.

If you have an older camera without HDMI, use the best quality analog video output connections 
provided by the camera and connect to the corresponding analog video input connections on H.264 
Pro Recorder. You will also need to connect analog audio.

Camera Outputs
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12 Month Limited Warranty
Blackmagic Design warrants that this product will be free from defects in materials and workmanship for 
a period of 12 months from the date of purchase. If a product proves to be defective during this warranty 
period, Blackmagic Design, at its option, either will repair the defective product without charge for parts 
and labor, or will provide a replacement in exchange for the defective product. 

In order to obtain service under this warranty, you the Customer, must notify Blackmagic Design of the 
defect before the expiration of the warranty period and make suitable arrangements for the performance 
of service. The Customer shall be responsible for packaging and shipping the defective product to a 
designated service center nominated by Blackmagic Design, with shipping charges pre paid. Customer 
shall be responsible for paying all shipping changes, insurance, duties, taxes, and any other charges for 
products returned to us for any reason. 

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or 
inadequate maintenance and care. Blackmagic Design shall not be obligated to furnish service under 
this warranty: a) to repair damage resulting from attempts by personal other than Blackmagic Design 
representatives to install, repair or service the product, b) to repair damage resulting from improper 
use or connection to incompatible equipment, c) to repair any damage or malfunction caused by the 
use of non Blackmagic Design parts or supplies, or d) to service a product that has been modified or 
integrated with other products when the effect of such a modification or integration increases the time or 
difficulty of servicing the product. THIS WARRANTY IS GIVEN BY BLACKMAGIC DESIGN IN LIEU OF ANY 
OTHER WARRANTIES, EXPRESS OR IMPLIED. BLACKMAGIC DESIGN AND ITS VENDORS DISCLAIM 
ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
BLACKMAGIC DESIGN’S RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE 
WHOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR ANY INDIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER BLACKMAGIC DESIGN 
OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES. BLACKMAGIC 
DESIGN IS NOT LIABLE FOR ANY ILLEGAL USE OF EQUIPMENT BY CUSTOMER. BLACKMAGIC IS 
NOT LIABLE FOR ANY DAMAGES RESULTING FROM USE OF THIS  PRODUCT. USER OPERATES THIS 
PRODUCT AT OWN RISK. 

Copyright 2011 Blackmagic Design. All rights reserved. ‘Blackmagic Design’, ‘DeckLink’, ‘HDLink’, ‘Workgroup Videohub’, ‘ Videohub’, ‘DeckLink’, 
‘Intensity’ and ‘Leading the creative video revolution’ are registered trademarks in the US and other countries. All other company and product 
names may be trade marks of their respective companies with which they are associated.
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